Equation Editor

Microsoft Word XP and 2003

To Add Equation Editor to Word toolbars

· Go to the View menu – Toolbars – Customize.
· Click the Commands tab in the window.
· On the left side of the window (Categories), scroll down the list to “Insert” and click on it.
· On the right side of the window (Commands), scroll down the list to Equation Editor (approximately halfway down the list). Look for the icon (a blue Greek alpha symbol in a pink square root).
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Click on the Equation Editor icon and drag it up to one of the toolbars in Word and let go of the mouse when it is positioned where you want to put it. You will know it is in an acceptable position when a large black    is visible in the toolbar. The icon should appear in the toolbar after you let go of the mouse button.

Teachers Please Note:
The basic installation for Microsoft Office XP and 2003 does NOT install the information needed to access Equation Editor. If it has not been included in the installation, you will get a warning window asking for the Microsoft Office installation CD to be inserted in the drive. In most cases, this will have to be done by the school technician, in order to bypass security such as Deep Freeze.

If the button cannot be installed, you can insert an equation through the following menu command:



Insert         Object         Microsoft Equation 3.0
This will open the correct Equation Editor window and will allow you to work with equations.
Using Equation Editor

1. Click on the Equation Editor icon in the toolbar. [image: image46.png]Customize
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  OR follow the instructions at the bottom of page 1.
2. A new window appears, with a specialized text box and the Equation toolbar visible.

3. You can get information about using the Equation Editor by going to the Help menu when the editor is active. 
Please Note: In order to move through the equation, you can either click in the appropriate box with your mouse, or use the arrow keys (up, down, right, or left) on the keyboard. Always make sure you have used the right arrow key to move out of the section of any equation. For example, if you type in the numbers for a denominator, you need to use the right arrow to move your cursor out of the denominator for the next part of the equation. You should see an underscore beneath the section of the equation you are typing in.
The Equation Toolbar


The top row of the Equation Editor toolbar has buttons for inserting more than 150 mathematical symbols, many of which are not available in the standard Symbol font. To insert a symbol in an equation, click a button on the top row of the toolbar, and then click the specific symbol from the palette that appears under the button.

The bottom row of the Equation Editor toolbar has buttons for inserting templates or frameworks that contain such symbols as fractions, radicals, summations, integrals, products, matrices, and various fences or matching pairs of symbols such as brackets and braces. Many templates contain slots — spaces into which you type text and insert symbols. There are about 120 templates, grouped on palettes. You can nest templates — insert templates in the slots of other templates — to build complex hierarchical formulas.

Each section of the Equation Editor toolbar is identified in the table below.
	Top Row – Mathematical Symbols
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	Relational Symbols
	These include less than and equal to, not equal to, and congruent to
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	Spaces and Ellipses
	These allow you to add spaces to your equation, as well as mathematical ellipses (patterns of three dots)
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	Embellishments
	These add various symbols above a character or characters, such as an overbar, arrows, dots, or tilde.
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	Operator Symbols
	These include plus/minus, multiply, divide, asterix, dot, and bullet.
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	Arrow

Symbols
	These are arrows of various appearances and directions.
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	Logical Symbols
	These are symbols for logical theorems and proofs, including therefore and such as.
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	Set Theory Symbols
	These symbols include element, union and intersection.
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	Miscellaneous Symbols
	Symbols include infinity, angle, perpendicular, and degree.
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	Greek Letters (lowercase)
	These are the lowercase letters of the Greek alphabet.
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	Greek Letters (uppercase)
	These are the uppercase letters of the Greek alphabet.

	Bottom Row – Templates and Frameworks
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	Fence
Templates
	Many different types of brackets and braces are provided, including absolute value.
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	Fraction & Radical
	Fractions (vertical and slanted) can be made in two sizes. Square roots and division are also included.
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	Superscript & Subscript
	Superscripts and subscripts on the left and right are provided, as well as over- and under-scripts.
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	Summation
Templates
	Summation characters with various limits are given.
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	Integral Templates
	Single, double and triple integrals with various limits are given.
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	Underbar & Overbar
	Single and double overbars and underbars are included. Arrows above and below are also in this section.
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	Labelled Arrow Templates
	Right, left, and double-pointing arrows are here, for both above and below a character.
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	Products & Set Theory
	Various templates for different set theory statements – products, union and intersection are provided.
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	Matrix Templates

	Various matrix templates are here, from 2-cell to variable-cell sizes and arrangements.


The following samples can be used as a simple tutorial for creating equations. For each one, open a document in Word 2007 and either type a few lines of text or press the Enter key a few times. This will put your equation in a more realist spot in the document. 
Sample 1: 
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To make this equation:

	1. 
	Insert a new equation, either from the toolbar or from the Insert menu.
	

	2. 
	The new equation box and toolbar will appear.
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	3. 
	Type y = and choose the basic square root from the Fraction & Radical Templates.
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	4. 
	While the cursor is flashing in the small box outline under the square root symbol, choose the small fraction (black boxes) from the Fraction & Radical Templates. Type 3 in the numerator and 16 in the denominator.
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	5. 
	Use the right arrow key on the keyboard. You will have to press the key more than once, since you have to arrow out of the fraction and also out of the square root symbol. Once you are outside the radical, type sin x. Type the minus sign. Note that the sin changes from italicized text to normal – the computer knows this is a function and should not be italicized.
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	6. 
	Type the c and then choose the superscript choice from the Fraction & Radical Templates. Type a 2 in the superscript to make the c2. Make sure you arrow to the right to move your cursor out of the superscript. 
	[image: image26.png]4]ocument! - MicrosoftWword O

Bl Edt Vew Fomat stje See Window telp

sec 1 11 A7 Ln1 Coll REC TR ExT o G






	7. 
	The plus/minus sign is the first option in the Operator Symbols library. The ( symbol is in the Greek Letters (lowercase) section. Type the tan x to complete the equation..
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Please note: The parts of an equation can be quite small on the screen. You can view the equation more easily if you zoom in (use the slider in the bottom right corner of your document window.)

Sample 2:
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To make this equation:

	1. 
	Insert a new equation, either from the toolbar or from the Insert menu.
	

	2. 
	The new equation box and toolbar will appear.
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	3. 
	Go to the Greek Letters (lowercase) andselect sigma ((). In the Fraction & Radical Templates area, choose the option with superscript and subscript on the right of the base. Type 2 in the superscript box, and x in the subscript box. Arrow to the right to make sure you are no longer in any of the parts and type the equal sign.
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	4. 
	Choose the full-sized fraction from the Fraction & Radical Templates and fill in the correct numerator and denominator. Use the right arrow to move out of the fraction, and select the braces from the Fence Templates. Click in the box within the braces to select it.
	[image: image31.png]“]Document1 - Microsoft Word [ [OF

Ele Edt Vew Fomat Stle Sge Window belp

1 a0 In1 ot REC TRK EXT OW






	5. 
	With the box selected, choose the third option in the Summation Templates, with boxes above, below and to the right of the (
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	6. 
	Fill in the correct information above and below the symbol. Click in the box to the right. Type in the X and then choose the option with superscript and subscript on the right of the base from the Fraction & Radical Templates. Fill in the information required, and make sure you use the right arrow to move to the end of this section of the equation.
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	7. 
	Type the minus sign and the n and the X. In the Embellishments section of the top row, choose the overbar. 
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	8. 
	Now select the superscript option in the Fraction & Radical Templates. Complete the equation by inserting the correct information for the exponent.
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Please note: The parts of an equation can be quite small on the screen. You can view the equation more easily if you zoom in (use the slider in the bottom right corner of your document window.)

Sample 3:
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Notes: Notice that this equation is much the same as Sample 2, except that it is inside a radical. You could copy the previous equation and paste it inside the radical symbol.

Sample 4:
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Notes: The default Style for letters in Equation Editor is Math – lettering is in italics, unless it is a recognized function. It works best for this equation to choose Text in the Style menu at the top of the document. This may have to be selected separately for different parts of the equation. Then highlight the As and the Bs and change them to Math style.
Sample 5:
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Notes: Pay close attention to the parts of the equation which have the underscoring. This will give you clues about the position of the cursor. For example, if you want to ensure you are in the right position to place an exponent, make sure the entire section is included in the underscore.
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Sample 6:
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Notes: I chose the under-script option in the Subscript & Superscript Templates for the lim sup. The program automatically recognized this as a limit, and did not italicize the text.
Sample 7:
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Notes: The ((I – A) was made first with italicized letters. Then the I and the A were turned into text and made bold. I chose the single vertical bars option from the Fence Templates for the last section of this equation. Inside the bars, I selected a 2-column, 2-cell matrix from the Matrix Templates. I used several spacing characters (these do not print, but push parts of the equation apart) to align the parts of the matrix at the minus signs.
Sample 8:
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Notes: The dot in <( ( exp> is a dot operator and is found in the Operator Symbols on the top row.
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